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Preface

Thank you for purchasing TOSHIBA Multifunctional Digital Systems or Multifunctional Digital Color Systems. This manual 
explains the instructions for TopAccessDocMon. Read this manual before using your Multifunctional Digital Systems or 
Multifunctional Digital Color Systems. Keep this manual within easy reach, and use it to configure an environment that 
makes best use of the e-STUDIO’s functions.

How to read this manual

Symbols in this manual
In this manual, some important items are described with the symbols shown below. Be sure to read these items before 
using this equipment.

Other than the above, this manual also describes information that may be useful for the operation of this equipment with 
the following signage:

Model and series names in this manual
In this manual, each model name is replaced with the series name as shown below.

Screens
Illustrations for a control panel and a touch panel shown in this manual are those of the e-STUDIO4520C Series. The 
details on the touch panel menus may differ depending on how the equipment is used, such as the status of the 
installed options.
The Illustration screens used in this manual are for paper in the A/B format. If you use paper in the LT format, the 
display or the order of buttons in the illustrations may differ from that of your equipment.

Indicates a potentially hazardous situation which, if not avoided, could result in death, serious 
injury, serious damage, or fire in the equipment or surrounding objects.

Indicates a potentially hazardous situation which, if not avoided, may result in minor or moderate 
injury, partial damage to the equipment or surrounding objects, or loss of data.

Indicates information to which you should pay attention when operating the equipment.

Describes handy information that is useful to know when operating the equipment.

Pages describing items related to what you are currently doing. See these pages as required.

Model name Series name
e-STUDIO5520C/6520C/6530C e-STUDIO6530C Series

e-STUDIO2330C/2820C/2830C/3520C/3530C/4520C e-STUDIO4520C Series

e-STUDIO2500C/3500C/3510C e-STUDIO3510C Series

e-STUDIO281C/351C/451C e-STUDIO451C Series

e-STUDIO555/655/755/855 e-STUDIO855 Series

e-STUDIO523/603/723/853 e-STUDIO853 Series

e-STUDIO520/600/720/850 e-STUDIO850 Series

e-STUDIO205L/255/305/355/455 e-STUDIO455 Series

e-STUDIO353/453 e-STUDIO453 Series

e-STUDIO352/452 e-STUDIO452 Series

e-STUDIO203L/233/283 e-STUDIO283 Series

e-STUDIO202L/232/282 e-STUDIO282 Series
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Trademarks
The official name of Windows 2000 is Microsoft Windows 2000 Operating System.
The official name of Windows XP is Microsoft Windows XP Operating System.
The official name of Windows Vista is Microsoft Windows Vista Operating System.
The official name of Windows Server 2003 is Microsoft Windows Server 2003 Operating System.
The official name of Windows Server 2008 is Microsoft Windows Server 2008 Operating System.
Microsoft, Windows, Windows NT, and the brand names and product names of other Microsoft products are 
trademarks of Microsoft Corporation in the US and other countries.
Apple, AppleTalk, Macintosh, Mac, Mac OS, Safari, TrueType, and LaserWriter are trademarks of Apple Inc. in the US 
and other countries.
Adobe, Adobe Acrobat, Adobe Reader, Adobe Acrobat Reader, and PostScript are trademarks of Adobe Systems 
Incorporated.
Mozilla, Firefox and the Firefox logo are trademarks or registered trademarks of Mozilla Foundation in the U.S. and 
other countries.
IBM, AT and AIX are trademarks of International Business Machines Corporation.
NOVELL, NetWare, and NDS are trademarks of Novell, Inc.
TopAccess is a trademark of Toshiba Tec Corporation.
Other company names and product names in this manual are the trademarks of their respective companies.
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Features and Functions

TopAccessDocMon consists of the status monitor and a job manager component that allow you to monitor your device and 
manage your print and network fax jobs from your computer desktop.

The status monitor allows you to check on your display the device-summary information and printer information, such 
as cassettes and counters. The feature also provides you with event notification (alerts); if a certain event, such as a 
paper out condition, interrupts printing, TopAccessDocMon will let you know it with an alert icon and a message.

 P.27 “MONITORING DEVICE STATUS”
The job management feature provides the access to the print queues (Print, Private Print, Hold Print, Proof Print, 
Scheduled Print, Fax, e-Filing, and Invalid queues) and helps you follow the progress of each job until it is printed on 
your device . You can also delete or release your jobs in these queues.

 P.35 “MANAGING JOBS”
And more!

 P.43 “OTHER USEFUL FUNCTIONS”
 P.47 “ADVANCED SETTINGS”
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Supported Models

TopAccessDocMon supports device monitoring and job management of the following TOSHIBA controllers:
e-STUDIO6530C Series
e-STUDIO4520C Series
e-STUDIO3510C Series
e-STUDIO451C Series
e-STUDIO855 Series
e-STUDIO853 Series
e-STUDIO850 Series
e-STUDIO455 Series
e-STUDIO453 Series
e-STUDIO452 Series
e-STUDIO283 Series
e-STUDIO282 Series

Other than the above, TopAccessDocMon can also monitor the status of the devices that support MIB-II, Host 
Resource MIB, and Printer MIB.
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System Requirements

The software requires the following environment:
OS
Windows 2000 Service Pack 4
Windows XP Service Pack 1/Service Pack 2/Service Pack 3
Windows Vista Service Pack 1
Windows Server 2003 Service Pack 1
Windows Server 2008
Display resolution
1024 x 768 dots or more
Display color
High Color (16 bit) or higher recommended
CPU
Pentium 133 MHz minimum (Pentium 266 MHz or faster recommended)
Memory
The required memory size for OS.
Network
TCP/IP or IPX/SPX

TopAccessDocMon requires an Windows network environment. To monitor and manage print jobs via another 
network environment, use TopAccess.
To monitor and mange print jobs using TopAccessDocMon, the SNMP network service must be enabled. To enable 
the SNMP network service, use TopAccess.

 P.45 “Accessing to TopAccess”
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This chapter describes the instructions on how to install the software.
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Before Installation

Before installing TopAccessDocMon, read the following carefully to ensure an appropriate installation.

TopAccessDocMon is already installed
If TopAccessDocMon is already installed on your computer, download TopAccessDocMon on the website and installed it 
again to update the software.
if you uninstall TopAccessDocMon and install it again, TopAccessDocMon can leave and restore the settings. When you 
see the “do you want to delete the settings for the following components?” message during uninstallation, select [no] to 
restore the settings.

GL-DocMon is installed
If GL-DocMon for the GL-1010 or GL-1020 controller is installed on your computer, uninstall GL-DocMon prior to installing 
TopAccessDocMon.

SC-DocMon is installed
If GL-DocMon for the SC-2 controller is installed on your computer, uninstall SC-DocMon prior to installing 
TopAccessDocMon.
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Installing TopAccessDocMon

Follow the procedure below to install TopAccessDocMon.

You need to log in Windows with the “Power Users” privilege (only for Windows 2000) or “Administrator” privilege (for 
Windows 2000/XP/Vista/Server 2003/Server 2008).

The following steps provide an example on Windows Vista.
The steps are the same on other Windows OS.

1 Follow the instructions on the download website and start the installation.

2 Select the language and click [OK].

3 Click [Next].

4 Select [I accept the terms in the license agreement] and click [Next].
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5 Click [Next].

To install to a different folder, click [Change] and specify the desired folder.

6 Click [Install].

7 Click [Finish] to close the wizard.

If you select the [Show the readme file] check box, the readme screen is displays.
Be sure to read the readme file; it contains notes and reminders for the TopAccessDocMon users.
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Uninstalling TopAccessDocMon

Follow the procedure below when you uninstall TopAccessDocMon.
The following steps provide an example on Windows Vista.
The steps are the same on other Windows OS.

1 Open the Control Panel and click [Uninstall a program].

The [Uninstall or Change a Program] dialog box is displayed.
On Windows 2000, click [Add/ Remove Programs].
On Windows XP/Server 2003, click [Add or Remove Programs].

2 From the list, select [TopAccessDocMon] and click [Uninstall].

On Windows 2000/XP/Server 2003, select [TopAccessDocMon] and click [Remove].

3 Click [Yes].
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4 Click [Yes].

5 To delete the setting files, click [Yes].

The system starts deleting the files.

If you plan to install the software later again, click [No] to keep the setting files. You can restore the data and 
settings when you re-install the software.
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Repairing TopAccessDocMon

When TopAccessDocMon does not work correctly, you can repair the software.

Do not repair the software if your computer is running Windows XP without Service Pack 2 or later installed. In this 
case, uninstall the software and then install it again.

The following steps provide an example on Windows Vista.
The steps are the same on any other Windows OS.

1 Double-click the icon of the “setup.exe” file downloaded from the website.

2 Select the language and click [OK].

3 Click [Next].

4 Select [Repair] and click [Next].

If TopAccessDocMon is activated, the following dialog box appears. To continue the process, click [OK].
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5 Click [Install].

6 Click [Finish] to close the wizard.

7 To restart your computer to reflect the changes, click [Yes]; if you wish to restart later, 
click [No].
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This chapter describes basic operation of TopAccessDocMon.
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TopAccessDocMon Summary

1) TopAccessDocMon Icon
Serves as a gateway to diverse features.

 P.19 “Launching TopAccessDocMon”

2) Document Monitor Taskbar Menu
Offers you a selection of services including starting/ending the session, configuration, and more!

 P.45 “Document Monitor Taskbar Menu”

3) TopAccessDocMon Window
Displays the device summary and various types of jobs.

 P.25 “TopAccessDocMon Window”

4) Configuration Dialog Box
Allows you to customize TopAccessDocMon to suit your preferences.

 P.48 “Customizing TopAccessDocMon”

12

3

4
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Launching TopAccessDocMon

You have the following 2 options to access the TopAccessDocMon window.
 P.19 “Accessing from TopAccessDocMon icon”
 P.20 “Accessing from the Printers and Faxes folder”

Accessing from TopAccessDocMon icon
You can access the TopAccessDocMon window from the TopAccessDocMon icon in the system tray.
The following steps provide an example on Windows Vista.
The steps are the same on any other Windows OS.

1 From [Start]> [All Programs] > [TOSHIBA e-STUDIO Client], select 
[TopAccessDocMon].

The TopAccessDocMon icon appears on the system tray.

2 Right-click on the TopAccessDocMon icon and, from the menu that appears, select 
[TopAccessDocMon].

The TopAccessDocMon window is displayed.
The TopAccessDocMon window displays the information for the printer set as a default printer in the Printers 
and Faxes folder. If the default printer is not set to a TOSHIBA printer or network fax driver, an error message is 
displayed instead of the TopAccessDocMon window.
If the connection to the printer is not properly set, a [message] dialog box appears. In this case, click [OK] to 
search for a printer and establish the connection.

 P.21 “Connecting to TOSHIBA MFP”

If you have any additional printers/faxes you want to monitor, see the following section:
 P.31 “Registering additional printers”
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Accessing from the Printers and Faxes folder
You can access the TopAccessDocMon window from the [Printers and Faxes] or [Printers] folder. Selecting a printer or 
network fax driver in the folder will display the TopAccessDocMon window with the selected device information.
The following steps provide an example on Windows Vista.
The steps are the same on any other Windows OS.

1 Open the [Printers and Faxes] or [Printers] folder.

2 Select and right-click on a driver icon and, from the menu that appears, select 
[TopAccessDocMon].

The TopAccessDocMon window appears for the selected device.
If the connection to the printer is not properly set, a [message] dialog box appears. In this case, click [OK] to 
search for a printer and establish the connection.

 P.21 “Connecting to TOSHIBA MFP”

If you have any additional devices you want to monitor, see the following section:
 P.31 “Registering additional printers”
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Connecting to TOSHIBA MFP

When the [Local Discovery] dialog box appears, you can either use the printer discovery feature to automatically search a 
printer in your network or enter the printer’s network address manually.

 P.21 “Searching MFPs automatically”
 P.22 “Entering IP address manually”

This function is used to connect to TOSHIBA MFP from TWAIN Driver, File Downloader, Remote Scan Driver, and 
Address Book Viewer.

Searching MFPs automatically

The following steps provide an example on Windows Vista.
The steps are the same on any other Windows OS.

1 Click [Start Discovery].

TopAccessDocMon locates the compatible printers in your network.

You can quit the process by clicking [Stop Discovery].
Devices in different segments may not be found. If you cannot find the device you are looking for, find it 
manually from [Manual Selection].

 P.22 “Entering IP address manually”
The search process may take long especially when many clients exist on the network. In this case, change 
the discovery settings from [Advanced].

 P.51 “Changing Network Discovery Settings”

To search a printer on the IPX/SPX network, press [Advanced] and select the IPX/SPX network search 
option. The TOSHIBA MFPs can be found in the IPX/SPX network also when the Local Discovery dialog 
box is displayed in applications other than TopAccessDocMon.

 P.51 “Changing Network Discovery Settings”
When the [Local Discovery] dialog box is displayed in applications other than TopAccessDocMon, the target 
TOSHIBA MFPs may not be found due to the SNMP settings. In this case, verify and/or change the settings 
on the [SNMP Settings] dialog box. For help, see the following section:

 P.53 “Changing SNMP Settings”
The SNMP settings cannot be set when the Local Discovery dialog box is displayed from Printer Drivers, N/
W Fax Driver, and TopAccessDocMon.
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2 From the list of the found devices, select the name of your TOSHIBA MFP and click 
[OK].

TopAccessDocMon connects to the selected device.

Selecting a wrong device will invoke a message dialog box. In this case, click [No] to return to the [Local 
Discovery] dialog box and select a correct device.

If your attempt to find the target TOSHIBA MFP fails, try to find it by manually entering its IP address.
 P.21 “Searching MFPs automatically”

Entering IP address manually

The following steps provide an example on Windows Vista.
The steps are the same on any other Windows OS.

1 Click [Manual Selection].

The [Manual Selection] dialog box appears.
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2 Enter the following items and click [OK].

IPv4 IP Address — Enter the IPv4 address of the printer.
IPv6 IP Address — Enter the IPv6 address of the printer.
IPX Address — Enter the IPX address of the printer. This item is available only when both of the following 
conditions are satisfied:

The IPX/SPX protocol and Novell Client are installed in your computer.
The computer is connected to the NetWare server.

The TOSHIBA MFPs can be discovered in the IPX/SPX network if the [Local Discovery] dialog box is displayed 
from other than TopAccessDocMon.
Name — Enter the printer name.
Location — Enter the location of the printer.
[SNMP Settings] — Click this button when you need to verify and/or change the SNMP settings. This is displayed 
only when the Local Discovery dialog box is displayed in other applications than TopAccessDocMon. 
The SNMP settings cannot be set when the [Local Discovery] dialog box displayed from Printer Drivers, N/W-Fax 
Driver, and TopAccessDocMon.

 P.53 “Changing SNMP Settings”

You must fill in the [Name] and either the [IP Address] or [IPX Address] boxes.
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3 The device specified in Step 2 is added to the list. Select the name of the added 
TOSHIBA MFP and click [OK].

TopAccessDocMon connects to the selected device.

Selecting a wrong device will invoke a message dialog box. In this case, click [No] to return to the [Local 
Discovery] dialog box and select a correct device.

When the [Local Discovery] dialog box is displayed in other applications than TopAccessDocMon, the target 
TOSHIBA MFPs may not be found due to the SNMP settings. In this case, verify and/or change the settings 
on the [SNMP Settings] dialog box. For help, see the following section:

 P.53 “Changing SNMP Settings”
The SNMP settings cannot be set when the [Local Discovery] dialog box displayed from Printer Drivers, N/
W-Fax Driver, and TopAccessDocMon.
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TopAccessDocMon Window

On the TopAccessDocMon window, you can switch tabs to check the device summary and the status of jobs. The window 
consists of the following components:

1) Menu Bar
The following menus are available:
- Printer — Click this menu when closing the window or switching devices to monitor.
- Document — Click this menu to start or delete jobs.
- View — Click this menu to display the [configuration] dialog box or update the device summary information.
- Help — Click this to access to the online help or the version information.

2) Tab
The following tabs are available:
- Device Status

 P.27 “MONITORING DEVICE STATUS”
- Print Queue
- Private Print
- Proof Print
- Scheduled Print
- Fax
- e-Filing
- Invalid

 P.35 “MANAGING JOBS”

3) Status Bar
On the status bar, the information such as printer status, IP address, the number of documents, and connection status 
are displayed in text or with icons. The available information varies depending on each tab.
- Status — Provides the information such as printer status and the number of jobs.
- IP/IPX Address — Shows the IP or IPX address of the controller connected to the selected printer.
- Connection Status — The icon here shows the communication status of the printer.
- Printer Icon — Clicking on this icon updates the information.

You can choose whether or not to show the status bar by selecting/deselecting the Status Bar option in the [View] 
menu.

1
2

3
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This chapter describes how to use TopAccessDocMon to monitor the status of your device.
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[Device Status] Tab

The [Device Status] tab allows you to view the detailed device information, check the printer status, and register additional 
devices.

1) Printer Image
The printer image provides a visual representation of the printer, showing the device status icon when the printer 
experiences an error.

 P.29 “Device Status Indicators”

2) Device Details
The following detailed device information is displayed:
- Name — Shows the distinctive printer name.
- Model — Shows the name of the printer model.
- Location — Shows the printer’s physical location.
- Status — Shows the status message that indicates the status of the device.
- Hole Punch — Shows the type of the hole punch unit installed.
- Physical Address — Shows the printer’s machine address (a unique ID for the printer’s network card, also 

referred to as the hardware address).

3) Printer Information
The Printer Information list box displays the drawer status icon along with the information about error, warnings, toner, 
and the counters.

4) Description
Description provides the details of the selected item in the Printer Information list box.

5) [Add Device]
Click this button when you need to register additional printers.

 P.31 “Registering additional printers”

1

2

3

4

5
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Checking Device Status

You can check the printer status on the Printer Image and the Printer Information areas.
These two areas show icons that represent the device status when the printer encounters an error. Although 
TopAccessDocMon enjoys periodic update, you can also update the information manually.

 P.29 “Device Status Indicators”
 P.30 “Updating Device Summary Information”

Device Status Indicators
Printer Error 1

This icon indicates a non-recommended toner cartridge is used and the equipment stopped printing. For information 
on resolving the error condition, refer to “Replacing a Toner Cartridge” in Troubleshooting Guide.
Printer Error 2

This icon indicates:
- You need to remove paper from the receiving tray.
- You need to remove paper from the Finisher tray.
- You need to remove the staples jammed in the Finisher. For information on resolving the error condition, refer to 

“Staple Jam in the Finisher” in Troubleshooting Guide.
- You need to remove the staples jammed in the Saddle Stitch unit. For information on resolving the error condition, 

refer to “Staple Jam in the Saddle Stitch unit” in Troubleshooting Guide.
- You need to clear the hole punch paper bits from the Hole Punch Unit. For information on resolving the error 

condition, refer to “Cleaning the Hole Punch Dust Bin” in Troubleshooting Guide.
- An unrecommended toner cartridge is being used. For information on resolving the error condition, refer to 

“Replacing a Toner Cartridge” in Troubleshooting Guide.
- You performed saddle stitch printing with the paper of the different sizes.
- The equipment cannot load paper from the Large Capacity Feeder.
- The equipment cannot eject the paper to the inner tray. (e-STUDIO4520C Series only)

Cover Open

This icon indicates the front cover is open.
Toner Empty

This icon indicates no toner is left. It also indicates which color is empty. For information on resolving the error 
condition, refer to “Replacing a Toner Cartridge” in Troubleshooting Guide.

Waste Toner Full

This icon indicates the waste toner box is full and requires replacing. For information on resolving the error condition, 
refer to “Replacing the Waste Toner Box” in Troubleshooting Guide.
Paper Empty

This icon indicates no paper is left in a drawer. For information on resolving the error condition, refer to Copying 
Guide.
Paper Jam

This icon indicates a paper jam occurred. For information on resolving the error condition, refer to “Clearing a Paper 
Jam” in Troubleshooting Guide.
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Staples Empty

This icon indicates no staples are left in the Finisher. For information on resolving the error condition, refer to “Refilling 
the Staple” in Troubleshooting Guide.
Call for Service

Contact your service representative to have the equipment inspected.

Updating Device Summary Information
When you want to manually update the device status information, either select View > Refresh, or click the printer icon on 
the right side of the status bar.

To change the auto-update settings, see the following section:
 P.50 “Changing Refresh Rates”
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Monitoring Multiple Devices

Registering additional devices allows you to monitor multiple devices by alternately switching between them. 
TopAccessDocMon can register up to 15 devices.

 P.31 “Registering additional printers”
 P.34 “Switching between devices”

Registering additional printers
To register additional devices you want to monitor, follow either of the following procedures:

 P.31 “Adding new devices with Auto-search function”
 P.33 “Adding new devices manually”

Adding new devices with Auto-search function

The following steps provide an example on Windows Vista.
The steps are the same on other Windows OS.

1 On the [Device Status] tab, click [Add Device].

The [TopAccessDocMon Network Discovery] dialog box appears.
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2 Click [Start Discovery].

You can quit the process by clicking [Stop Discovery].
TopAccessDocMon may not be able to find devices that are located in different segments. In this case, add 
these devices manually from [Manual Selection].

 P.33 “Adding new devices manually”
The search process may take long especially when many clients exist on the network. In this case, change 
the discovery settings from [Advanced].

 P.51 “Changing Network Discovery Settings”

To search a printer on the IPX/SPX network, press [Advanced] and select the IPX/SPX network search option.
 P.51 “Changing Network Discovery Settings”

3 From the list of the found printers, select the check box of the printer you want to 
monitor and click [  Add].

The selected device is added to the Monitoring Device list.

The maximum printers can be added is 15.
To remove any device(s) from the Monitoring Device list, select the checkbox of the device(s) you want to 
remove and click [Remove].
You cannot remove devices that are related to the installed printer drivers.

4 Click [OK].
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Adding new devices manually

The following steps provide an example on Windows Vista.
The steps are the same on other Windows OS.

1 On the [Device Status] tab, click [Add Device].

The [TopAccessDocMon Network Discovery] dialog box appears.

2 Click [Manual Selection].

The [Manual Selection] dialog box appears.
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3 Enter the following items and click [OK].

IPv4 IP Address — Enter the IPv4 address of the printer.
IPv6 IP Address — Enter the IPv6 address of the printer.
IPX Address — Enter the IPX address of the printer. This item is available only when both of the following 
conditions are satisfied:

The IPX/SPX protocol and Novell Client are installed in your computer.
The computer is connected to the NetWare server.

Name — Enter the printer name.
Location — Enter the location of the printer.

You must fill in the [Name] and either the [IP Address] or [IPX Address] boxes.

4 The specified printer is added to the [Monitoring Device] list. Click [OK].

To remove any device(s) from the Monitoring Device list, select the checkbox of the device(s) you want to 
remove and click [Remove].
You cannot remove devices that are related to the installed printer drivers.

Switching between devices
To change from one device to another, go to Printer > Change Printer and select the name of the desired device.
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This chapter provides instructions on how to use TopAccessDocMon to manage jobs.
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Document Monitor Tabs

The [Print Queue], [Private Print], [Proof Print], [Scheduled Print], [Fax], [e-Filing], and [Invalid] tabs are called Document 
Monitor tabs, where you can check the status of the print queues and control the print and network fax jobs. Print jobs are 
sorted out mainly into [Print Queue], [Private Print], [Proof Print], and [Scheduled Print] tabs whereas network fax jobs are 
managed on the [Fax] tab. When you save documents in e-Filing, the [e-Filing] tab allows you to check if the documents 
are successfully saved. If your job is turned out invalid and remains unfinished, you can retry printing on the [Invalid] tab. If 
your printer is shared with other network users, their print jobs are also displayed on these tabs. The information on each 
tab is basically the same.

The number of tabs available depends on the selected device.
The hold print jobs are displayed in the [Private Print] tab.

1) Document Name
You can identify the job with the name of the document.

2) Status
Statuses of jobs are displayed under this column.

3) Scheduled (the [Scheduled Print] tab only)
This item shows the date and time set for the job to print the document.
The Scheduled print is not displayed.

4) User Name
You can identify the sender of a particular job.

5) Pages
This item shows the total number of pages for the job and the number of pages finished to print.

6) Submitted
This item shows the date and time the job was sent to the controller.

7) Copies
This item shows the number of copies requested to print.

1
2
3
4
5
6
7
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Deleting Jobs

On each of the document monitor tabs, you can cancel or delete your print or network fax jobs before or after they are 
pushed from the queue.
The following steps provide an example on Windows Vista.
The steps are the same on other Windows OS.

1 Click the tab containing the job you want to delete and select the job.

You can only select the jobs that you sent from your computer.

2 From the [Document] menu, select [Cancel].

The “Your document has been cancelled” message is displayed. Click [Close].
The selected job is deleted.

You can also deleting the job following procedures: 
- Select the job from the [Document] menu that you want to delete.
- Right click and click [Cancel] in the menu displayed.
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Releasing Proof Print Jobs

Proof print jobs initially print only a single copy to allow you to check the printout of a job requesting multiple copies. On the 
[Proof Print] tab, you can resume this kind of on-hold jobs to print out the remaining copies.
The following steps provide an example on Windows Vista.
The steps are the same on other Windows OS.

1 Click the [Proof Print] tab and select a job whose remaining copies you want to print 
out.

You can only select the jobs that you sent from your computer.

2 From the [Document] menu, select [Release Proof].

The [Release Proof] dialog box appears.

3 Enter the number of copies and click [OK].

The “Your proof set has been printed” message is displayed. Click [Close].
The remaining copies of the selected job are printed.
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Releasing Scheduled Print Jobs Immediately

On the [Scheduled Print] tab, you can immediately release the scheduled print jobs irrespective of the originally set 
schedule.
The following steps provide an example on Windows Vista.
The steps are the same on other Windows OS.

1 Click the [Scheduled Print] tab and select a job you want to release from the queue 
immediately.

You can only select the jobs that you sent from your computer.

2 From the [Document] menu, select [Print Now].

The selected scheduled print job is immediately printed.
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Monitoring Documents to Storage

TopAccessDocMon can display the status of documents from your computer, which are sent to and stored into e-Filing.
 P.40 “Store to e-Filing”

Store to e-Filing
The [e-Filing] tab displays the properties of the jobs and documents stored into e-Filing of the device. The information is 
displayed only for about 60 seconds. To learn more about e-Filing, refer to the e-Filing Guide.
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Releasing Invalid Jobs

Invalid job refers to a job that is kept unfinished due to some wrong operation; for example, you might have entered an 
invalid department code when the department management is enabled. On the [Invalid] tab, you can release this kind of 
invalid jobs as shown in the following steps.
The following steps provide an example on Windows Vista.
The steps are the same on other Windows OS.

1 Click the [Invalid] tab and select a job you want to release from the queue.

You can only select the jobs that you sent from your computer.
The invalid jobs for exceeding the limitation for number of copies cannot be released.

2 From the [Document] menu, select [Invalid Release].

The [Invalid Release] dialog box appears.

3 Enter the 5-digit department code and click [OK].

The selected invalid job is printed.
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Event Notification

Event notification refers to the function of TopAccessDocMon to notify users of specific changes in the device or job status. 
Examples of the events include paper jam, paper empty, completion of printing, and deletion of a job. These events are 
notified with a pop-up dialog box and/or an audible sound.

If the SNMP communication is disabled on the printer driver, the event notification of the TopAccessDocMon will also 
be disabled.

The pop-up dialog box displays the following information:

1) Date/Time
This item indicates the date and time when the event has been notified.

2) Document
This item indicates the name of the document in the job.

3) Message
The message relevant to the event is displayed in the field.

4) Notification Number
This item shows the sequence number for the message currently displayed on the pop-up dialog box.

5) Navigation Buttons

 — Clicking this button displays the first message.

 — Clicking this button displays the previous message.

 — Clicking this button displays the next message.

 — Clicking this button displays the last message.

6) [Close]
Clicking on this button closes the pop-up dialog box.

For instructions on how to change the event notification settings, see the following section:
 P.49 “Changing Event Notification settings”

1
2
3

4

5

6
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Document Monitor Taskbar Menu

From the Document Monitor Taskbar Menu, you can access not only the TopAccessDocMon window but other useful 
functions as well.

 P.45 “Disabling event notification”
 P.45 “Accessing to the Configuration dialog box”
 P.45 “Ending TopAccessDocMon sessions”
 P.45 “Accessing to TopAccess”

Disabling event notification
You can enable/disable the event notification according to your needs. To disable the event notification, right-click on the 
TopAccessDocMon icon and, from the displayed menu, select [Disable]. To enable the event notification, select [Enable].

Accessing to the Configuration dialog box
Selecting [Configure] on the taskbar menu opens the [configuration] dialog box. If you want to customize 
TopAccessDocMon to suit your preferences, change the settings on the [configuration] dialog box. For details, see the 
following section:

 P.48 “Customizing TopAccessDocMon”

Ending TopAccessDocMon sessions
If you select [Close] on the taskbar menu, you can end the TopAccessDocMon session and close the window and the 
dialog boxes at a time.

Accessing to TopAccess
You can access TopAccess from TopAccessDocMon. On the taskbar menu, select [TopAccess]. To learn more about 
TopAccess, refer to the TopAccess Guide.

You can access TopAccess only when one of the following devices is set as the default printer: 
e-STUDIO6530C Series
e-STUDIO4520C Series
e-STUDIO3510C Series
e-STUDIO451C Series
e-STUDIO855 Series
e-STUDIO853 Series
e-STUDIO850 Series
e-STUDIO455 Series
e-STUDIO453 Series
e-STUDIO452 Series
e-STUDIO283 Series
e-STUDIO282 Series
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Online Help

Sometimes you might need to check the features and functions of TopAccessDocMon while actually operating it. In such a 
case, the online help is useful. On the TopAccessDocMon window, select Help > Contents and Index. The 
TopAccessDocMon Help dialog box appears, where you can search for the items you need to know about.
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Customizing TopAccessDocMon

If you want to customize TopAccessDocMon, change the advanced settings from the [configuration] dialog box. You have 
3 options to access to the configuration dialog box:

Double-click the TopAccessDocMon icon on the system tray.
Right-click on the TopAccessDocMon icon and, on the menu that appears, select [Configure].
On the TopAccessDocMon window, select View > Configure.

The optional settings available for change are the startup, the event notification, and the refresh rates. You can also check 
the network address of each device on the [configuration] dialog box. The dialog box consists of the following tabs:

[Startup] — Use this tab to select whether or not to show the TopAccessDocMon icon when starting Windows.
 P.48 “Setting up the Startup option”

[Notification] — Use this tab to select events for the event notification and how to notify them.
 P.49 “Changing Event Notification settings”

[Refresh Rates] — Use this tab to specify how often TopAccessDocMon detects the device and notify events and 
updates the device summary and the print queues information. 

 P.50 “Changing Refresh Rates”
[Installed] — Use this tab to check the network address of each device.

 P.50 “Viewing the Network Address of your printer”

Setting up the Startup option
On the [Startup] tab, you can select whether or not to display the TopAccessDocMon icon at the startup of Windows. To 
select to display the icon, select the [Run the document monitor when starting Windows] check box.
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Changing Event Notification settings
The [Notification] tab allows you to select events TopAccessDocMon notifies and the ways it does.

 P.44 “Event Notification”

1) Events
Clicking on the arrow button in the Events frame displays the list of events that can be notified of. Select the 
checkboxes for the messages corresponding to the events described below.

*1 Only for the devices with the Fax option.
*2 The notification of this event is not available for the e-STUDIO6530C Series, e-STUDIO4520C Series, e-STUDIO3510C Series, 

e-STUDIO451C Series, e-STUDIO855 Series, e-STUDIO850 Series, e-STUDIO455 Series, e-STUDIO452 Series and e-STUDIO282 
Series.

*3 For e-STUDIO6530C Series only.

2) Method
Select how TopAccessDocMon notifies you of an event.
- Popup Dialog — Selecting this option displays a pop-up message when an event occurs.
- Audio (Beep) — Selecting this option causes your computer to produce a beep at the time of an event.

Events Descriptions
Document has been printed successfully The printer has finished printing the document.
Private print document is being held The private print or hold print job sent to the controller is ready for printing. Perform 

printing on the control panel.
Proof set has been printed The printer has printed the first copy of your multi-copy job, which is ready for your 

review before releasing and printing the remaining copies.

Fax has been transmitted successfully*1 The printer has sent a fax that you sent through the N/W-Fax driver.

Document has been cancelled by the printer The printer has cancelled the job. The reason might be an unavailable paper size 
or the satisfied timeout conditions. The message is displayed only when 
catastrophic circumstances force the printer to cancel the job, such as a missing 
byte or memory failure. However, expired private or proof print jobs are never 
cancelled by the printer.

Document cannot be printed due to error The printer is unable to print the job.
Fax Transmission failure The printer has failed in sending a fax through the N/W-Fax driver.
Document is held as Invalid Your print job is held as an invalid job because of exceeding the limitation for 

number of copies.
Printer has a paper jam There is a paper jam in the printer.

Printer is offline*2 The printer is off-line.

Drawer is out of paper One of the printer drawers is out of paper. This drawer may not be the one the 
printer is using for your job.

Printer door is open The cover on the printer is open.
Printer requires attention The printer is in an error condition that requires immediate attention or 

maintenance.
Toner is empty The toner cartridge is empty.
Used toner container is full The waste toner container is full.
Toner is low The toner cartridge is near empty.

Prepare new waste toner box*3 The waste toner box becomes nearly full.

1

2
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Changing Refresh Rates
On the [Refresh Rates] tab, you can change the refresh rates for the three items: document notification, printer status, and 
print queue.

1) Item/Refresh Rates List Box
The list box shows the refresh rate settings for the following items:
- Document Notification
- Printer Status
- Print Queue

2) [Restore Defaults]
Clicking on this button restores the default settings of the refresh rates.

3) [Change Rate]
To change the refresh rate, select an item from the Item list and click this button. The dialog box corresponding to the 
selected item appears where you can select the desired refresh rate with the slide bar. The refresh rates can be set 
within the following ranges:
- Document Notification — 0 second (i.e. no refresh) to 1 minute in 10-second increments. The default is 30 

seconds.
- Printer Status — 0 second (i.e. no refresh) to 5 minute in 30-second increments. The default is 1 minute.
- Print Queue — 0 second (i.e. no refresh) to 1 minute in 10-second increments. The default is 10 seconds.

Viewing the Network Address of your printer
On the [Installed] tab, you can check the IP address for each device.

1) Printer Name
This column lists the name of each printer or network fax driver.

2) Port
This column displays the port on your computer to which the printer driver is connected.

3) IP/IPX Address
This column displays the IP/IPX address of the device the printer/network fax driver maps.

4) [Update]
Clicking on this button updates the devices’ network address information.

1

2 3

1
2

3
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Changing Network Discovery Settings

When using TopAccessDocMon and connecting to your printer for the first time, or when registering an additional printer, 
you need to find the device on the network.

 P.21 “Connecting to TOSHIBA MFP”
 P.31 “Registering additional printers”

The search process may take long especially when many clients exist on the network. In this case, you can narrow down 
the search conditions on the Discovery Settings dialog box. The settings available for change vary between the following 2 
cases:

 P.51 “Initial Connection”
 P.52 “Additional Printer Registration”

Initial Connection
If you are trying to establish the connection to the device for the first time, click [Advanced] on the [Local Discovery] dialog 
box and, on the [Discovery Settings] dialog box that appears, change the following settings:

1) Devices
Click the arrow button to display the pull-down list box and check the box for the model name that you want to search 
for.

2) Network
Enable IPX/SPX Search
Select this option to search for the devices on the IPX/SPX network. This option is available when both of the following 
conditions are satisfied:
- The IPX/SPX protocols and Novel Client are installed to your computer.
- Your computer is connected to the NetWare server.

The TOSHIBA MFPs can be discovered in the IPX/SPX network if the [Local Discovery] dialog box is displayed from 
other than TopAccessDocMon.
Enable TCP/IP Search
Select this option to search for the devices on the TCP/IP network. This option is available only when the TCP/IP 
protocols are installed to your computer. When you select this option, you also need to specify the detailed search 
conditions for the devices on the network.
- Search local subnet — Select this option to search for devices in the local subnet.
- Specify a range — Select this option to search for printers in a specific range of IPv4 or IPv6 addresses. When 

this is selected, select IPv4 or IPv6 and enter the IP addresses in the [From] and the [To] boxes.

3) [SNMP Settings]
Click this button when you need to verify and/or change the SNMP settings.

 P.53 “Changing SNMP Settings”

The SNMP settings cannot be set when the [Local Discovery] dialog box displayed from Printer Drivers, N/W-Fax 
Driver, and TopAccessDocMon.

1

2

3
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Additional Printer Registration
If you are trying to register additional devices, click [Advanced] on the [TopAccessDocMon Network Discovery] dialog box 
and, on the [Discovery Settings] dialog box that appears, change the following settings:

1) Devices
Find TOSHIBA Devices
Select this option to search your network only for TOSHIBA MFPs that are supported. (  P.7)

Find All Devices on the Network
Select this option to search for all compatible devices.

2) Network
Enable IPX/SPX Search
Select this option to search for printers connected to the IPX/SPX network. This option is available when both of the 
following conditions are satisfied:
- The IPX/SPX protocols and Novel Client are installed to your computer.
- Your computer is connected to the NetWare server.

Enable TCP/IP Search
Select this option to search for the devices on the TCP/IP network. This option is available only when the TCP/IP 
protocols are installed to your computer. When you select this option, you also need to specify the detailed search 
conditions for the devices on the network.
- Search local subnet — Select this option to search for devices in the local subnet.
- Specify a range — Select this option to search for printers in a specific range of IPv4 or IPv6 addresses. When 

this is selected, select IPv4 or IPv6 and enter the IP addresses in the [From] and the [To] boxes.

1

2
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Changing SNMP Settings

If you cannot find the target TOSHIBA MFPs on your network, the SNMP settings might be worth suspecting. Verify the 
correct SNMP settings on the [SNMP Settings] dialog box and change the settings, if needed. The dialog box can be 
accessed by clicking [SNMP Settings] on the [Discovery Settings] (  P.51) or the [Manual Selection] dialog box (  P.22).

This function is available only when Local Discovery dialog box is displayed in other applications than 
TopAccessDocMon.
Ask the administrator for details on the SNMP Network settings configured for your TOSHIBA MFP.

1) Version
Be sure to have the correct SNMP version set for your TOSHIBA MFP and select from the following options:
- V1/V2 — Select this option to enable SNMPV1 and V2.
- V3 — Select this option to enable SNMPV3.
- V1/V2/V3 (for [Discovery Settings] dialog box only) — Select this option to enable SNMPV1, V2, and V3.

To find your TOSHIBA MFP under the SNMP V1/V2 environment, the community name set for the target TOSHIBA 
MFP must be [public]. For help, consult the administrator.

2) SNMP V3
If SNMPv3 is enabled, use the [option button] to select the way to authenticate users.
User ID File — Select this option when you want to use a user ID file. Click [Browse] and specify the user ID file.
User Name/Password — Select this option when you want to use the user name and password. When this option is 
selected, keyboard or select the following items:
- User Name
- Authentication Protocol
- Authentication Password
- Privacy Protocol
- Privacy Password

If you select to enable SNMPV3, consult your network administrator for preliminary advice on how to 
authenticate users.
Each entry for User Name, Authentication Password, and Privacy Password can consist of up to 32 one-byte 
alphanumeric characters.

2

1
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Error Conditions

If you experience difficulties as shown below, find out the conditions that might be causing the trouble and take the 
appropriate steps to correct the error.

 P.56 “The device does not respond”
 P.56 “Cannot view jobs in the TopAccessDocMon print queue”

The device does not respond

Problem description
The status bar reads, “The device is not responding” and the icon indicating broken connection is displayed on the 
taskbar.
Technically, this icon means that the SNMP manager on the client machine cannot communicate with the SNMP agent on 
the device. Several error conditions can cause this status:

The network connection between the client and the device has been broken.
The device IP address has been changed whereas the client is still using the old address.
The device is currently being restarted.
The SNMP agent on the device is malfunctioning or has stopped functioning.

Corrective action
1. Log in to TopAccess in the Administrator mode and make sure that the SNMP network service is enabled on the 

Network Setup page. To learn more about TopAccess, refer to the TopAccess Guide.
2. Wait for a couple of minutes. Most of the time, the connection is reestablished automatically.
3. If the broken connection condition persists, exit and restart TopAccessDocMon.
4. If, during the restart process of TopAccessDocMon, you see a message telling that the network address cannot be 

resolved, manually discover and select the device.
 P.21 “Connecting to TOSHIBA MFP”

Cannot view jobs in the TopAccessDocMon print queue

Problem description
After sending a job to print documents, you may not see the job in the print queue because of the following reasons:

A wrong device has been selected.
The job is queued on the Windows operating system print spooler.
The job may be held in the Novell print queue.
The device is experiencing some error.

Corrective action
Check the device for the correct name and location and see if any jobs are listed for the device.
Check the Jobs Log on TopAccess to see if the job status listed is either “Done,” or “Deleted,” or “Unserviceable.”
If the job involves with small data, your printer may have already finished printing. If the job is unserviceable for some 
reason, the printer will automatically delete the job from the queue.
Check the Touch Panel Display for any error messages. For instance, a prompt to load paper holds up subsequent 
jobs in the queue.
In a Peer to Peer environment, the job may be queued on the Microsoft Windows operating system print spooler and, 
consequently, not available in the Current Jobs list or the Jobs Log. If you do not see any error messages, and if the 
printer seems to be working fine, resubmit the job.
The job may be in the Novell print queue and, thus, not visible for the moment. Use NWAdmin or PCONSOLE to check 
the queue for any errors.
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TopAccessDocMon Status Messages

This section describes TopAccessDocMon status messages.
 P.57 “Event notification messages”
 P.58 “Alert information messages”

Event notification messages
The following table contains the event notification messages and their detailed descriptions including what to do in each 
situation.

Message Description
Your document has been printed. User has sent a print job and it has finished printing successfully.

Your private print document is now being held. A user sent a private print job and it is ready for the user to perform printing on the 
control panel.

Your hold print document is now being held. A user sent a hold print job and it is ready for the user to perform printing on the 
control panel.

Your proof set has been printed. User has sent a proof copy of a multi-copy job has printed, and it is ready for the user 
to review before releasing and printing the remaining copies.

Your fax has been transmitted successfully. User has sent a fax job and it has finished faxing successfully.

Your document has been cancelled. A user sent a print job and it has been changed to a cancelled state. If this message 
is notified after a private, hold, proof or scheduled print job has been sent, the job has 
been cancelled before it is put into a hold state. This may occur because of a missing 
byte or memory failure. In this case, ask your administrator to maintain the available 
hard disk space to store jobs, or delete unnecessary stored ones and resubmit the 
job.

Your document cannot be printed due to error. User has sent a print job and it was rendered unserviceable by this equipment.  
Make sure you use the correct printer driver.

Fax transmission failure The transmission of a fax job that was sent using N/W-Fax driver failed. Make sure 
you specify the correct destinations.

Document is held as invalid The print job is held as an invalid job because of exceeding the limitation for number 
of copies.  Make sure you specify the number of copies that does not exceed the 
limitation.

The printer has a paper jam. A paper jam has occurred. Remove the jam and resubmit the job.

The printer is offline. The printer is offline. This may be displayed by monitoring other TOSHIBA device. 
Turn the printer online and resubmit the job.

The printer is out of paper. One of the drawers is out of paper.  Add paper.

The printer door is open. One of the doors is opened. Close the door.

The printer requires attention. An error has occurred. Go to the Touch Panel Display to see the type of error. For 
more details on resolving the error, refer to the Troubleshooting Guide or consult 
your network administrator.

The yellow toner is Empty.
The magenta toner is Empty.
The cyan toner is Empty.
The black toner is Empty.

One of the toner cartridges is empty.  Replace it.
Toner Empty message for yellow, magenta, cyan toners are displayed only for 
e-STUDIO6530C Series, e-STUDIO4520C Series, e-STUDIO3510C Series, and 
e-STUDIO451C Series.

Prepare new waste toner box Prepare a new waste toner box. (This message is displayed only for the 
e-STUDIO6530C Series)

The used toner container is full. The toner bag is full.  Replace the toner bag.

The yellow toner is Low.
The magenta toner is Low.
The cyan toner is Low.
The black toner is Low.

One of the toner cartridges is low.  Replace it.
Toner Near Empty message for yellow, magenta, cyan toners are displayed only for 
e-STUDIO6530C Series, e-STUDIO4520C Series, e-STUDIO3510C Series, and 
e-STUDIO451C Series.
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Alert information messages
The following table contains the Alert information messages displayed by clicking an icon in the Printer Information list box 
on the [Device Status] tab and helps you find out what to do in each situation.

Status Messages Description
Paper Empty Paper Empty in Drawer 1 - Please Add Paper Add paper in the Drawer 1.

Paper Empty in Drawer 2 - Please Add Paper Add paper in the Drawer 2.

Paper Empty in Drawer 3 - Please Add Paper Add paper in the Drawer 3.

Paper Empty in Drawer 4 - Please Add Paper Add paper in the Drawer 4.

Paper Empty in Large Capacity Feeder - Please Add 
Paper.

Add paper in the Large Capacity Feeder.

Cover Open Platen Cover Open - Please Close Cover Close the Platen Cover.
Front Cover Open - Please Close Cover. Close the Front Cover.
Paper Feeding Cover Open - Please Close Cover. Close the Paper Feeding Cover.
Transfer/Transport Unit Open - Please Close Cover. Close the Transfer/Transport Unit.
Lower Side Cover Open - Please Close Cover. Close the LCF Feeding Cover.
Drawer Open - Please Close Cover. Close the Drawer Cover.
Automatic Document Feeder Cover Open - Please 
Close Cover.

Close the Automatic Document Feeder cover.

Relay Unit Cover Open - Please Close Cover. Close the Relay Unit Cover.
Finisher Door Open - Please Close Door. Close the Finisher Door.
Lower Tray Delivery Cover Open - Please Close Cover. Close the Lower Tray Delivery Cover.
Lower Tray Front Cover Open - Please Close Cover. Close the Lower Tray Front Cover.
Hole Punch Unit Front Cover Open - Please Close 
Cover.

Close the Punch Unit Front Cover.

Hole Punch Unit Cover Open - Please Close Cover. Close the Punch Unit Cover.
Inserter Unit Cover Open - Please Close Cover Close the Inserter Unit Cover.
Exit Cover Open - Please Close Cover Close the Exit Cover.

Job Separator Cover Open - Please Close Cover. *1 Close the Job Separator Cover.

Offset Tray Cover Open - Please Close Cover. *1 Close the Offset Tray Cover.

Automatic Duplexing Unit Cover Open - Please Close 
Cover.

Close the Automatic Duplexing Unit Cover.

Lower Tray Transport Cover Open- Please Close Cover Close the Lower Tray Transport Cover.

Bypass Cover Open - Please Close Cover *2 Close the Bypass Cover.

Toner Cover Open - Please Close Cover *2 Close the Toner Cover.
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Paper Jam Paper Jam in Automatic Document Feeder - Please 
Clear Paper Path

Follow the instructions displayed on the touch panel to 
remove jammed paper.

Paper Jam in Bypass Tray - Please Clear Paper Path Follow the instructions displayed on the touch panel to 
remove jammed paper.

Paper Jam in Drawer 1 - Please Clear Paper Path Follow the instructions displayed on the touch panel to 
remove jammed paper.

Paper Jam in Drawer 2 - Please Clear Paper Path Follow the instructions displayed on the touch panel to 
remove jammed paper.

Paper Jam in Large Capacity Feeder - Please Clear 
Paper Path

Follow the instructions displayed on the touch panel to 
remove jammed paper.

Paper Jam in Drawer 3 - Please Clear Paper Path Follow the instructions displayed on the touch panel to 
remove jammed paper.

Paper Jam in Drawer 4 - Please Clear Paper Path Follow the instructions displayed on the touch panel to 
remove jammed paper.

Paper Jam in Finisher - Please Clear Paper Path Follow the instructions displayed on the touch panel to 
remove jammed paper.

Paper Jam in Printer - Please Clear Paper Path Follow the instructions displayed on the touch panel to 
remove jammed paper.

Paper Jam in Job Separator - Please Clear Paper Path. Follow the instructions displayed on the touch panel to 
remove jammed paper.

Paper Jam in Offset Tray - Please Clear Paper Path. Follow the instructions displayed on the touch panel to 
remove jammed paper.

Paper Ejection Jam - Please Clear Paper Path Follow the instructions displayed on the touch panel to 
remove jammed paper.

Paper Insertion Jam - Please Clear Paper Path Follow the instructions displayed on the touch panel to 
remove jammed paper.

Paper Jam in Automatic Duplexing Unit - Please Clear 
Paper Path

Follow the instructions displayed on the touch panel to 
remove jammed paper.

Paper Jam in Inserter Unit - Please Clear Paper Path *2 Follow the instructions displayed on the touch panel to 
remove jammed paper.

Paper Jam in External Large Capacity Feeder - Please 
Clear Paper Path *2

Follow the instructions displayed on the touch panel to 
remove jammed paper.

Toner Near Full Prepare new waste toner box. *6 Prepare a new waste toner box.

Toner Full Used Toner Container Full - Please Replace. Replace the Toner Container. Refer to the 
Troubleshooting Guide or Operator’s Manual for 
Basic Functions for instruction.

Toner Empty Black Toner Empty - Please Replace. Follow the instructions displayed on the touch panel to 
replace the Black Toner.

Cyan Toner Empty - Please Replace. *3 Follow the instructions displayed on the touch panel to 
replace the Cyan Toner.

Magenta Toner Empty - Please Replace. *3 Follow the instructions displayed on the touch panel to 
replace the Magenta Toner.

Yellow Toner Empty - Please Replace. *3 Follow the instructions displayed on the touch panel to 
replace the Yellow Toner.

Toner Near Empty Black Toner Cartridge Low - Please Install New 
Cartridge Before System is Empty.

Replace the Black Toner. Refer to the Troubleshooting 
Guide or Operator’s Manual for Basic Functions for 
instruction.

Cyan Toner Cartridge Low - Please Install New 
Cartridge Before System is Empty. *3

Replace the Cyan Toner. Refer to the Troubleshooting 
Guide or Operator’s Manual for Basic Functions for 
instruction.

Magenta Toner Cartridge Low - Please Install New 
Cartridge Before System is Empty. *3

Replace the Magenta Toner. Refer to the 
Troubleshooting Guide or Operator’s Manual for 
Basic Functions for instruction.

Yellow Toner Cartridge Low - Please Install New 
Cartridge Before System is Empty. *3

Replace the Yellow Toner. Refer to the 
Troubleshooting Guide or Operator’s Manual for 
Basic Functions for instruction.

Staple Empty Staple Empty - Please Set Staple Cartridge Set the Staple Cartridge. Refer to the Troubleshooting 
Guide or Operator’s Manual for Basic Functions for 
instruction.

Finisher’s Lower Tray Staples are Empty - Please 
Replace Staple Cartridge

Set the Saddle Staple Cartridge. Refer to the 
Troubleshooting Guide or Operator’s Manual for 
Basic Functions for instruction.

Status Messages Description
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*1 For e-STUDIO453 Series, e-STUDIO283 Series, e-STUDIO452 Series, and e-STUDIO282 Series only.
*2 For e-STUDIO6530C Series, e-STUDIO855 Series, and e-STUDIO850 Series only.
*3 For e-STUDIO6530C Series, e-STUDIO4520C Series, e-STUDIO3510C Series, and e-STUDIO451c Series only.
*4 For e-STUDIO6530C Series, e-STUDIO4520C Series, e-STUDIO453 Series, e-STUDIO283 Series, e-STUDIO452 Series, and e-STUDIO282 

Series only.
*5 For e-STUDIO4520C Series, and e-STUDIO3510C Series only.
*6 For e-STUDIO6530C Series only.

Printer Error Finisher Disconnected - Please Join Finisher to Copier. Join the Finisher to the copier stably.
Hole Punch Jam in Finisher - Please Clear Hole Punch Clear hole punches from the Finisher. Refer to the 

Troubleshooting Guide or Operator’s Manual for 
Basic Functions for instruction.

Staple Jam in Finisher - Please Clear Staple Remove jammed staples from the Finisher. Refer to the 
Troubleshooting Guide or Operator’s Manual for 
Basic Functions for instruction.

Staple Jam in Lower Tray of Finisher - Please Clear 
Staple

Remove jammed staples from the Saddle Stitch 
Finisher. Refer to the Troubleshooting Guide or 
Operator’s Manual for Basic Functions for 
instruction.

Toner Not Recognized - Please Check Toner Check and adjust the toner bottle.
Finisher Lower Tray Full - Please Remove Paper Remove paper from the Lower Tray of Saddle Stitch 

Finisher.
Mixed Sized Paper not Allowed - Please Check Paper Check the paper.
Finisher Tray 1 Paper Full - Please Remove Paper. Remove paper from the Finisher Tray 1.
Finisher Tray 2 Paper Full - Please Remove Paper. Remove paper from the Finisher Tray 2.

Inner Tray Paper Full - Please Remove Paper. *4 Remove paper from the Inner Tray.

Hole Punch Full in Finisher- Please Clear Hole Punch. Dispose the punched paper bits. Refer to the 
Troubleshooting Guide or Operator’s Manual for 
Basic Functions for instruction.

Job Separator Upper Paper Full - Please Remove 
Paper. *1

Remove paper form the Job Separator Upper Tray.

Job Separator Lower Paper Full - Please Remove 
Paper. *1

Remove paper from the Job Separator Lower Tray.

Offset Tray Full - Please Remove Paper. *1 Remove paper from the Offset Tray.

Printer Output Error - Please Contact Service 
Technician.

Contact your service representative.

Printer Input Error - Please Contact Service Technician. Contact your service representative.
Time for Slit Glass and Main Charger Cleaning - Please 
Clean Slit Glass and Main Charger *5

Clean Slit Glass and Main Charger. Refer to the 
Troubleshooting Guide or Operator’s Manual for 
Basic Functions for instruction.

Contact Service 
Technician

Automatic Document Feeder Error - Please Contact 
Service Technician.

Contact your service representative.

Alignment Error in Automatic Document Feeder - 
Please Contact Service Technician.

Contact your service representative.

Motor Error in Automatic Document Feeder - Please 
Contact Service Technician.

Contact your service representative.

I/F Error in Automatic Document Feeder - Please 
Contact Service Technician.

Contact your service representative.

Fatal Error - Please Contact Service Technician. Contact your service representative.
Main Motor Error - Please Contact Service Technician. Contact your service representative.
Fuser Error - Please Contact Service Technician. Contact your service representative.
Scanner Error - Please Contact Service Technician. Contact your service representative.
Motor Error - Please Contact Service Technician. Contact your service representative.
HDD Error - Please Contact Service Technician. Contact your service representative.
The Time for Periodic Maintenance - Please Contact 
Service Technician.

Contact your service representative.
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